Multimedia Approaches to Learning the Foundations of Library and Information Science

Elysia Guzik, Faculty of Information, University of Toronto
eylsia.guzik@alum.utoronto.ca
Brian Griffin, Faculty of Information, University of Toronto
brian.griffin@mail.utoronto.ca
Jenna Hartel, Faculty of Information, University of Toronto
jenna.hartel@utoronto.ca

This paper presents a case study of two types of multimedia resources that were integrated as supplementary learning materials into the design and delivery of two different graduate courses on the historical foundations of library and information science (LIS): video and audio lectures from an online course on the history of information (integrated into a doctoral seminar), and a curated playlist of a weekly public radio broadcast on the history of ideas (integrated into a master’s course). It also considers some of the limitations of compiling LIS-related audiovisual materials from disparate online sources, with references to examples. By analyzing and critiquing these three applications of multimedia resources in LIS graduate courses, this paper attempts to answer the following research question: Beyond traditional pedagogical strategies such as lectures and text-based readings and assignments, how might students, practitioners, and the general public gain a sweeping understanding of our field? The paper aims to help LIS educators to diversify their pedagogical strategies and reach people outside their classrooms. By incorporating these kinds of multimedia resources into course designs, educators may help to empower students to actively and creatively apply what they learn in class to the analysis of historical events, biographies, and social movements, develop technical skills that will benefit their professional development, and produce deliverables that can be shared on public platforms to reach a wider audience beyond LIS classrooms.

Keywords: education, history of information, LIS, multimedia, pedagogy, podcasts, video

This paper presents a case study of two types of multimedia resources that were integrated as supplementary learning materials into the design and delivery of two different graduate courses on the historical foundations of library and information science (LIS). It also considers some of the limitations of compiling LIS-related audiovisual materials from disparate online sources, with references to examples. By analyzing and critiquing these three applications of multimedia resources in LIS graduate courses, this paper attempts to answer the following research question: Beyond traditional pedagogical strategies such as lectures and text-based readings and assignments, how might students, practitioners, and the general public gain a sweeping understanding of our field? The paper aims to help LIS educators to diversify their pedagogical strategies and reach people outside their classrooms. By incorporating these kinds of multimedia resources into course designs, educators may help to empower students to actively and creatively apply what they learn in class to the analysis of historical events, biographies, and social movements, develop technical skills that will benefit their professional development, and produce deliverables that can be shared on public platforms to reach a wider audience beyond LIS classrooms.

Keywords: education, history of information, LIS, multimedia, pedagogy, podcasts, video
public gain a sweeping understanding of our field? It draws upon Professor Jenna Hartel’s ongoing experiments to enhance master’s and doctoral courses on the historical foundations of LIS at the University of Toronto’s Faculty of Information. After a brief statement on the use of various multimedia resources in graduate education, two types of audio-visual content specific to LIS are critically discussed: 1) the History of Information lectures from the University of California (Berkeley) School of Information (which were integrated into a doctoral seminar); and a curated playlist of episodes from the BBC Radio 4 program In Our Time (which was integrated into a master’s course). While the History of Information case reflects an example of teaching and learning with multimedia, the In Our Time case offers a precedent for teaching and learning through multimedia, since the deliverable was a multimedia object (i.e., a learner-produced podcast episode) rather than a research paper. The In Our Time case illustrates the extra value in assignments that facilitate learning how to use audio recording technology and the university’s media archive to share learner-produced content, not only with the instructor and peers but also with the university community and broader public.

Both the doctoral and master’s courses are part of required curricula in their respective programs. Although the syllabi for these courses are designed for two different groups of learners (i.e., the doctoral seminar is concerned primarily with the theoretical and methodological foundations of the LIS discipline, and the master’s course is focused more on the contributions of influential practitioners and how foundational literature about librarians’ values and competencies have shaped professional practice), both are rooted in the historical study of LIS. While standard course descriptions exist for both courses, syllabi and assignments vary as instructors change. This allows for a certain level of flexibility in terms of pedagogical techniques and themes that guide weekly readings, lectures, discussions, and the overall course trajectories. Textbooks are useful to help tie together themes and concepts from different journal articles and book chapters. In a similar way, using

### KEY POINTS:

- Multimedia resources such as curated playlists of podcasts and video lectures can enrich LIS graduate curriculum by building learners’ understanding of our field beyond required readings and lectures by a course instructor.

- Learner-produced podcast episodes on topics related to LIS develop learners’ communication and technological skills while providing opportunities for public engagement.

- Selected podcasts and video content are well suited to online courses, as LIS departments move increasingly in this direction.
recorded lectures and podcasts can help students tie together ideas from written course materials.

This paper does not reflect on examples of using multimedia in distance learning formats, nor are we proposing ideas for MOOCs or courses offered strictly online. Rather, this paper maintains a commitment to the in-class experience and advocates for extending the range of media through which students learn. With these caveats in mind, however, the ideas presented in this paper may also be applied in online courses, as LIS departments (and other disciplines) move increasingly in this direction.

**Literature review**

Educational psychologist Richard E. Mayer’s (2001) cognitive theory of multimedia learning suggests that students “learn best when interacting actively with course material” (Saunders & Hutt, 2015, p. 1235). Other empirical research, such as from engineering educators Fiona Saunders and Ian Hutt, supports this claim by drawing attention to the capacity for multimedia “to be paused, replayed and reflected upon” and to “provide a powerful tool for learning” (Saunders & Hutt, 2015, p. 1235). A study about supplementing in-person lectures in a Master of Science in the Management of Projects program at the University of Manchester with “rich-media materials”—namely “audio podcasts, audio-narrated slides, short video segments and full-video lecture capture”—found that these materials strengthened learners’ understanding (Saunders & Hutt, 2015, p. 1235). This study also found that students continued to value traditional in-person lectures and viewed the rich-media materials as complementary instead of replacement teaching tools.

Saunders and Hutt’s (2015) study is one example of research on teaching and learning in various disciplines—including language learning, medicine, entrepreneurship and organizational behavior, psychology, science and engineering, social work and community development, and teacher training—that has explored the use of YouTube videos and clips, podcasts, and other multimedia in undergraduate and graduate education (e.g. Byrne, McGovern, & Bradley, 2017; Clifton & Mann, 2011; Hudock & Warden, 2001; King, Greidanus, Carbonaro, Drummond, & Patterson, 2009; Lawlor & Donnelly, 2010; Pecay, 2017; Sun, 2014; Teckchandani & Obstfeld, 2017; Terantino, 2011). Much of this research focuses on using podcasts and YouTube videos to replace lecture time (e.g., O’Bannon, Lubke, Beard, & Britt, 2011), spark structured classroom discussions and review main ideas and concepts from courses, and support lectures (e.g., Berk, 2009; Fleck, Beckman, Sterns, & Hussey, 2014; Teckchandani & Obstfeld, 2017). According to this body of research, supplementing online and classroom-based courses with complementary online videos and podcasts—a practice known as “blended learning” (Garrison & Kanuka, 2004)—can enhance learners’ engagement in the course and expand their understanding (Buzzetto-More, 2014; Luna & Cullen, 2011;
Roodt & Peier, 2013; Teckchandani & Obstfeld, 2017). Learners’ understanding of course material—along with their critical thinking, analytical, collaboration, communication, and technology skills—can be further developed through employing active learning techniques, such as having learners produce a podcast (e.g., Armstrong, Tucker, & Massad, 2009; Byrne et al., 2017; Vasquez, 2015), rather than merely showing a video clip during class or asking that students listen to a podcast on their own time (Al-Jarf, 2012). Findings suggest that the format in which a course is delivered (i.e., online or classroom-based) affects the length of the content selected, which in turn influences learners’ decisions about whether or not to watch a video or listen to a podcast (Buzzetto-More, 2014).

According to business education and management professor Nicole A. Buzzetto-More (2014), there is no relationship between learners’ personal social media use and their perceptions about the value of including YouTube in course content.

Multimedia sources

Collecting various LIS-related multimedia sources

One option for educators who wish to include multimedia in their classrooms is to compile LIS-related materials from disparate sources. Some examples include the documentary film S. R. Ranganathan: The Man and His Mission (Guy, n.d.); the video-recorded public lecture by Marcia Bates (2012), On the Nature of the Information Professions; and the archived MOOC “New Librarianship Master Class” (Lankes, n.d.). Others have made video recordings and accompanying transcripts of public lectures held in LIS departments available online. For example, recordings from the 2013–14 Colloquia Series “Feminist & Queer Approaches to Technoscience,” hosted by the Faculty of Information at the University of Toronto, were compiled and made available as a special issue of The Scholar & Feminist Online, an online journal published by the Barnard Center for Research on Women (Keilty & Shade, 2016). Professor Steve Fuller has also recorded many of his keynote presentations and other lectures since 2005, and over 150 are available on his website (Fuller, 2017). Of these, 15 lectures would be of immediate interest to students of LIS, and many other recorded lectures are related to intersecting ideas, such as the importance of knowledge and science in society. Although Fuller is based in sociology, he is a champion of the concept of social epistemology (which has been attributed to information scientists Jesse Shera and Margaret Egan) and other foundational LIS topics.

Unfortunately, compiling LIS-related materials from such a variety of sources often means that the sound quality is also variable and links may disappear. Many sources lack metadata, which leads to additional time commitments for instructors who must then closely filter through and review materials to decide what is relevant and create their own
descriptions. Additionally, these disparate sources rarely address syllabus topics directly. Overall, while a reasonable selection of LIS-related multimedia sources exists, integrating such sources into LIS curricula by using this approach tends to lead to an idiosyncratic rather than systematic coverage of topics.

**Multimedia resource #1: The History of Information online course**

*INFO 103: History of Information* is an upper-level undergraduate course for students in information studies, cognitive science, history, and media studies at the Berkeley School of Information (iSchool), usually taught by Geoffrey Nunberg and Paul Duguid. According to the instructors, the course takes a “long view” of the ways in which earlier cultures and their information technologies, “from the earliest cave painting and writing systems . . . to the emergence of the computer and the Internet” (UC Berkeley School of Information, 2017), have influenced how we think about questions surrounding current information issues such as privacy, accuracy, and information overload. Several themes are carried across the entire course, including technological determinism, the rear-view mirror effect (where every new technology reflects the characteristics of what came before—e.g., elements of radio showing up in early television), and the “information age.” The lectures from several annual course offerings were recorded by Berkeley and distributed on YouTube, along with PowerPoint slides. They were also serialized as an audio podcast and made available on iTunes.² Table 1 lists the *History of Information* lecture topics.

<table>
<thead>
<tr>
<th>Table 1: History of Information lecture topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction: Why “History of Information”</td>
</tr>
<tr>
<td>The Telegraph in China</td>
</tr>
<tr>
<td>The “Age of Information”</td>
</tr>
<tr>
<td>Literacy &amp; the Nineteenth Century Public Sphere</td>
</tr>
<tr>
<td>Technological Determinism</td>
</tr>
<tr>
<td>Technologies of the Image</td>
</tr>
<tr>
<td>First Technologies: Writing</td>
</tr>
<tr>
<td>Information as Property</td>
</tr>
<tr>
<td>Cultural Effects of Writing</td>
</tr>
<tr>
<td>Broadcast</td>
</tr>
<tr>
<td>Manuscript Culture</td>
</tr>
<tr>
<td>Computer “Revolution”</td>
</tr>
<tr>
<td>Print “Revolution”</td>
</tr>
<tr>
<td>Visualizing Information</td>
</tr>
<tr>
<td>Emergence of the Public Sphere</td>
</tr>
<tr>
<td>Storage and Search</td>
</tr>
<tr>
<td>Reference Books &amp; Knowledge Organization</td>
</tr>
<tr>
<td>Advent of the Internet</td>
</tr>
<tr>
<td>Rise of Literacy and Standard Language</td>
</tr>
<tr>
<td>Social Implications of the Internet</td>
</tr>
<tr>
<td>Unnoticed Revolutions? Time and Money</td>
</tr>
<tr>
<td>Big Data</td>
</tr>
<tr>
<td>Communications “Revolution”</td>
</tr>
</tbody>
</table>
lecture topics that were used in the doctoral program’s *Foundations of Information* seminar.

**Class use of History of Information recordings**

The Faculty of Information at the University of Toronto’s PhD program in information studies begins with two years of coursework, followed by written and oral qualifying examinations, a thesis proposal and defense, and a written thesis and defense. In the first year of the program, PhD students take one qualitative research methods course and a *Foundations of Information* course that surveys the history of the field of information studies and examines the information concept in contemporary academic and everyday use.

Of the Faculty of Information’s 2013 first-year cohort of 10 PhD students, only three had master’s degrees in LIS. The other seven students had undergraduate and master’s degrees in communication studies, computer science, education, English, health/biological Science, and history. Students in this course completed the typical PhD-level course load of weekly readings from LIS journals and textbooks, along with intermittent writing assignments and a final term paper that referred to course readings. In addition to these readings and assignments, the doctoral-student cohort watched the YouTube videos or listened to the podcasts as supplemental texts, at the pace of about four recorded lectures per week over the semester.

Every week, some in-class time in *Foundations of Information* was devoted to discussing *History of Information* topics during class. Students were able to draw connections between weekly themes of our foundations course and the topics of the *History of Information* lectures. For example, our *Foundations of Information* course had a section of readings covering knowledge and its meanings in scientific and everyday discourse. The *History of Information* weekly lecture provided additional background on the history of knowledge in society and its relationship to communication and technology. Nunberg and Duguid are seasoned educators with different teaching styles, which prompted the doctoral students to view the online lectures through a pedagogical lens and to generate reflections on their own futures as teachers of information studies. Furthermore, due to the online lectures, the doctoral students recognized that two experts may be needed to do justice to the topic of information—an important, sobering, and humbling discovery. While viewing the *History of Information* altogether, participants in the course each found some of their own interests represented; these interests were woven together in the series, creating a newfound and unanticipated *esprit de corps*. At the end of the semester, students wrote an essay addressing the strengths and weaknesses of the *History of Information*, and responded to the question of how they might implement a similar course within the Faculty of Information at the University of Toronto. During one of the class meetings, students had the
opportunity to informally present their critique to the rest of the class and discuss how a similar history of information course could complement the Faculty of Information.

**Benefits**

With few exceptions (e.g., Gleick, 2011), there are no narrative histories of the information concept that would be immediately accessible to students with a range of disciplinary backgrounds. Since *History of Information* is a cross-listed course in several departments at Berkeley, the instructors take a long and wide view of the information concept and usually avoid disciplinary jargon and references, making the podcasts ideal as supplemental listening material for a first-year graduate foundations of information course. For example, one student wrote that the lectures “cover[] substantial ground and draw[] on a wide variety of sources from various disciplines.” Another student noted that “the course is extensive in both the time period that it attempts to cover and the material that is presented.” These comments reflect the range of perspectives on information presented throughout the course from the two instructors and their teaching assistant. This provided the foundations course an opportunity to discuss the ways in which the information concept is used by the two *History of Information* instructors (with respective disciplinary expertise in linguistics and history) and by their teaching assistant (with expertise in design and information visualization) and in everyday life.

**Drawbacks**

Although the *History of Information* lectures provided background for new students in the foundations course curriculum, there were some shortcomings to using the recorded lectures. Experiencing all 26 lectures is time consuming, requiring an investment of 40 hours. While some students were able to listen to the audio podcasts while doing other tasks, others did not have a way to listen to podcasts and instead watched the videos on YouTube. The recordings are also unedited and captured by the instructors through smart podiums in the classroom, so production quality varies and questions and comments from students in the lecture hall are inaudible. While these technical issues can be overlooked, students observed several other weaknesses with using the recorded lectures or implementing this as part of the Faculty of Information’s curriculum. The course is geared toward undergraduates, and the ideas presented were “not challenging enough for a Master’s level course” and “should focus on significant events in the history of information science” to make the course fit with the Faculty of Information’s current offerings.

On a final note, in March 2017, Berkeley announced that it would begin to remove publicly available course captures and other materials from YouTube and iTunes, citing growing concerns about accessibility for all students and the protection of instructors’ intellectual property (Public
Affairs, UC Berkeley, 2017). This illustrates the ephemerality of publicly available multimedia resources, the challenges of archiving multimedia, and the risks of relying on these materials.

Multimedia resource #2: Curated playlist from BBC Radio 4’s In Our Time

*In Our Time* is a weekly radio discussion series on the history of ideas, produced by BBC Radio 4 and hosted by British parliamentarian and broadcaster Lord Melvyn Bragg. Entering its 20th year, the program reaches an audience of over two million listeners per week. Each episode centres on a historical, philosophical, religious, cultural, or scientific topic. Bragg serves as the moderator among three featured academic guests. Each episode follows a similar structure:

- a short opening statement,
- an introduction to the episode’s panelists,
- question and answer discussion, and
- a short closing summary.

Every episode of *In Our Time* is available for streaming or download via the *In Our Time* Archive (BBC Radio 4, n.d.).

Class use of *In Our Time* episodes

The Faculty of Information at the University of Toronto offers a two-year, ALA-accredited Master of Information degree program with eight concentrations, including library and information science. Students have the option to pursue a coursework-based program or a thesis option that allows them to conduct an original study. For students who enrolled in the LIS concentration before September 2017, one of the core requirements was the *Foundations in LIS* course. This course was designed to provide an overview of the historical development of librarianship and information science and the ways in which core values and assumptions influence current and emerging practices in the information professions. In addition to core courses, students in the Master of Information program are expected to choose elective courses according to their specific professional and academic interests (e.g., public, special, academic, law, and art librarianship; information policy; digital curation; community outreach and advocacy; reading practices and information behavior, etc.).

As part of the instructional design for this course, Professor Hartel was inspired to carefully curate a shortlist of 28 out of over 700 relevant episodes following in-depth listening to this broadcast (one episode per day over nine months). Professor Hartel coined this shortlist the “*In Our Time* LIS playlist” and integrated it into the syllabus for the master’s-level foundations course to complement weekly course readings from scholarly literature and lecture/discussion topics, which introduced students to some of the specialized LIS vocabulary. Professor Hartel analyzed the complete *In Our Time* archive for relevant subjects using her knowledge of
LIS, the course syllabus, and the Table of Contents from the *Encyclopedia of Library and Information Sciences* (Bates, 2009) as frameworks for inclusion.

The *In Our Time* LIS playlist named 12 broad topics of relevance to the historical foundations of LIS and five narrower episodes of *In Our Time* that fit therein. The 12 topics were synchronized with the 12-week course schedule. For example, during the week of the course on “Organizing Knowledge,” there were *In Our Time* episodes about the *Encyclopédie*, the natural order (scientific classification), the calendar, the measurement of time, and chemical elements. To unify the listening experience across the cohort, students were instructed to listen to two episodes per week and to choose a third episode according to their interests.

As Saunders and Hutt (2015) point out, most existing research on audio podcasts in the classroom (e.g., Beilke, Stuve, & Williams-Hawkins, 2008; Bolliger, Supanakorn, & Boggs, 2010; Bongey, Cizadlo, & Kalnbach, 2006; Donnelly & Berge, 2006; Kazlauskas & Robinson, 2012; Pearce & Scutter, 2010; Sutton-Brady, Scott, Taylor, Carabetta, & Clark, 2009; Van Zanten, Somogyi, & Curro, 2010; Walls et al., 2010) addresses “rich-media materials . . . as optional additional resources, rather than as core material aimed at fostering specific learning strategies or increasing students’ critical thinking” (p. 1236). In contrast, the *In Our Time* LIS playlist and its associated assignment (discussed below) were key parts of the course design. The playlist offered a liberal arts approach to LIS education, in the sense of systematically and fervently pursuing “knowledge for its own sake” (Stebbins, 1994). This encouraged students to explore issues such as expertise, subject authority, sharing technical knowledge in a globalized society, information access, and exhibition practices with reference to historical trends, movements, and events outside of the existing LIS curriculum. Students were not expected to memorize facts from the *In Our Time* episodes but rather to foster a better understanding of how the academic study and professional practice of LIS could connect to the broader public. Furthermore, the playlist and its associated assignment were intended to empower students to gain direct experience with learning how to present research to a public audience, tell a compelling story, and share expertise in accessible language.

**Drawbacks**

While the *In Our Time* broadcast covers various geographies, histories, cultures, and traditions, the playlist was designed to highlight episodes that most closely aligned with issues in the history of LIS. As a result, content is somewhat limited to British and European perspectives. Moreover, the online archive of *In Our Time* episodes is confined to audio files. Although some episodes are available via YouTube, closed captions are not entirely accurate and no written transcripts are publicly available. Students also found that the sound quality varied, with occasional guests mumbling, speaking quietly, or sounding “monotone.” Students also noted the significant time commitment associated with the playlist, as they found it
difficult to multi-task while listening to the episodes and therefore needed to dedicate time strictly to listening. Finally, some students questioned the relevance and value of the playlist, as they were not tested on episode content in an exam and did not see connections to course content.

**Benefits**

The playlist exposed students to various topics and perspectives that are adjacent to LIS. It also introduced students to different ways of communicating expertise and telling stories. In a survey distributed in the second-last week of the term, one student noted, “I learned about topics that I probably would not have looked into on my own.” Another student commented, “the podcast listening was a nice way of starting to think about the assignment from the beginning of the term.” Other students said that they already enjoyed “podcasts as a medium” and found “many of [the *In Our Time* episodes to be] really interesting,” including “listening to the different personalities and the interplay among speakers.”

**The assignment**

In addition to the Playlist, the *In Our Time* program inspired a major group-based assignment for the course. Using the *In Our Time* “listenings” included in the playlist as a model for format and style, students formed groups of five or six to produce and record their own 10-minute mini-episodes on a relevant LIS topic of their choice. While creating the mini-episodes, students assumed roles as producer, host, world-class scholar #1, world-class scholar #2, world-class information professional, and technical manager. The mini-episodes were played and celebrated during the last session of the course and posted online for wider audiences to enjoy. Students’ impressions of the assignment were measured in an online evaluation survey and are reported below.

The 16 topics represented by the first iteration of this project by the fall 2016 class are as follows:

<table>
<thead>
<tr>
<th>Table 2: <em>In Our Time</em> assignment topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carnegie libraries</td>
</tr>
<tr>
<td>History of paper</td>
</tr>
<tr>
<td>Margaret Elizabeth Egan</td>
</tr>
<tr>
<td>The Rescue of the Timbuktu Manuscripts</td>
</tr>
<tr>
<td>The Imperial Library of Constantinople</td>
</tr>
<tr>
<td>The Indian Public Library</td>
</tr>
<tr>
<td>Henry Hobson Richardson</td>
</tr>
<tr>
<td>Early modern Vatican Library and Swedish National Library</td>
</tr>
</tbody>
</table>
Professor Hartel contacted the *In Our Time* host and producer and provided a summary report at the end of the term. The producer expressed interest in profiling the mini-episodes created for the assignment for an upcoming series episode.

**Drawbacks**

Given that this was the first time the assignment was offered, it presented some challenges. There was some confusion among students about role distribution and respective responsibilities—namely, a perception about imbalanced duties between producer, technical manager, and scholars/professionals. One student remarked that the assignment was “a bit too technologically dependent.” While some students found that the amount of work involved in producing the mini-episodes was comparable “to what I would have done for a conventional group paper,” others felt that this assignment required “more work . . . in the sense that in addition to research, references, and having to become knowledgeable in a subject area and then to worry about the audio preparations and recording, run-throughs, going over mistakes, multiple drafts of the script, getting all the group members to agree on meeting times, etc.” Like many other kinds of group projects, this assignment presented logistical challenges for students to find time to record as a group. Finally, this assignment was designed around public speaking—a skill with which students had varying levels of comfort and experience. One student admitted, “I can’t just make someone act better or read more naturally.” Students were also encouraged to balance a comedic tone (in the spirit of respectful imitation of the original broadcast) with the assignment’s academic requirements. As one student observed, this balance “felt a little awkward at times since creating a podcast is something completely new.”

**Benefits**

Despite these limitations, overall, students were enthusiastic about producing the mini-episodes. One participant suggested that “It would have been neat to do a full-length In Our Time episode!” Students appreciated the novel and participatory format and noted that working on something “different than ‘yet another essay’ . . . provided a chance to complete something more outside the box and fun than other types of more formal assignments.” This creative approach enabled students to become experts, build confidence about a topic of their group’s choice, and co-create knowledge.

Students recognized the value of this assignment for developing their professional competencies by actively learning as co-producers of content, rather than simply summarizing or analyzing content as they might for a conventional research paper assignment. Participants commented that the assignment encouraged “future librarians to expand their interest and knowledge by exploring unfamiliar topics, and then being able to engage
in conversation about new topics.” It also “taught librarian-appropriate
skills such as team work and information scanning (listening to IOT [In
Our Time] for structure rather than content) as well as an openness to
technology and using library resources (Toronto Reference Library stu-
dio).” In particular, the assignment helped students to develop technical
and problem-solving skills. For example, one student emphasized the
importance of

Testing the electronics . . . as well as asking questions regarding
what electronics would give us a better quality audio, not talking
too much into the microphone, and the different volume within
each person’s voice and how far they should speak.

Because the assignment led to a shareable output (i.e., MP3 audio files),
which demonstrated technical capacity, adaptability, project management,
collaboration, problem solving, leadership, and the ability to work under
time constraints/deadlines, it also offered a marketable portfolio piece for
library and information professionals.

Although the assignment was well received from students who were
already drawn to non-conventional projects (i.e., project formats other
than an essay), it was also accessible to students who were initially less
convinced about this format. The assignment was intentionally designed
to benefit from collaboration among students with various interests, per-
sonalities, and professional experiences. One student remarked,

It was a perfect assignment for those of us who are still struggling
to prepare work and present in front of an audience. . . . We were
able to record our information in a safe space, and still present it
the same way. It alleviates the nerves about messing up live. I also
think that you could argue that it is somewhat of a research paper
because our group conducted thorough research and wrote an
in-depth script.

Implementation

Students commented in the survey that the In Our Time assignment pro-
vided a memorable, engaging, and fun way to learn about foundational
LIS concepts, events, and figures and offered a valuable learning expe-
rience. For educators who are interested in implementing the assign-
ment in their classes, see Appendix A for the In Our Time assignment
description (including the LIS playlist), and Appendix B for technical
details.

The following section outlines reflections and recommendations on
the assignment’s project management and evaluation criteria. As noted
above, a critical part of the assignment is the use of audio-recording tech-
nology to produce the mini-episode. Since this was the first time offering
the assignment, there was a steep learning curve for instructors and
students to become familiar with the software for recording, editing, saving, and sharing the MP3 files. Classroom technology allowances will also differ across institutions and between classrooms in the same department. Fortunately, one student in Professor Hartel’s class had previous professional experience as a sound technician. This student volunteered to lead a tutorial on the recording software. This tutorial benefitted the students who attended, developed leadership and instructional skills for the student who led the tutorial, and provided helpful insights for the instructors who were also new to using the software. The instructors were also grateful for a technical appendix that this student created and shared with classmates via the course’s online portal.

In addition to the focused technical tutorial, the teaching assistant facilitated three in-class workshops. Workshop 1, hosted in week 6, served as the assignment launch. During this hour-long workshop, students formed groups of five or six, selected their roles as described on the assignment handout, and brainstormed topics for approval before the second workshop. During Workshop 2 in week 7, the teaching assistant provided an introduction to the audio-recording software, Audacity, discussed equipment and file format requirements, shared resources on technical advice, and approved group topics. Workshop 3, in week 8, provided students time during class hours to work with their groups, introduce their topics to the class, and check in with the teaching assistant and course instructor about their audio storyboard (i.e., an outline of how the 10-minute mini-episode would proceed, including estimated times allotted to each speaker). This was particularly useful for students who commuted to campus and had limited availability outside of class hours.

Students benefited from technology loans that were available for free with their student/library cards through the Faculty of Information’s library, the Inforum, and from audio-recording space and equipment that could be booked for free at two local public libraries. Audacity was selected over other software (e.g., Apple’s GarageBand) for its advantage as a free, open-source tool.

At the last class of the term, students were invited to a potluck buffet “listening party,” during which they listened to all mini-episodes that were produced for the assignment and celebrated a successful term. To prepare for the class, the teaching assistant compiled the mini-episodes onto a playlist (saved as links and MP3 files). Groups were asked to present a short introduction to their mini-episode (including their names, the topic they selected, and an anecdote about their production process) and were invited to display visual material on slides to complement their mini-episode. While students enjoyed the listening party, one student suggested that, “I also would have liked more time . . . to ask questions of each group.” Another student suggested that instead of listening to the entire mini-episodes, “it might be nicer for groups to present a summary
of their podcast.” These recommendations will be taken into account for future course offerings.

The assignment was graded based on the following criteria:

- quality of the content, including proper citations (50%);
- quality of audio production (consistently audible, no extravagant effects needed) (15%);
- resemblance to *IOT* broadcast (model key elements, roles from playlist) (20%); and
- engaging in-class presentation (students introduce themselves and roles, state topic and why they chose it, anecdote about working on the project) (15%).

Since it was the first time offering this assignment and because the software was new to the instructors and to most students in the class, the assignment was graded generously. This approach was meant to encourage students to focus on learning and taking creative risks, rather than grades.

**Recommendations**

Educators who may be interested in implementing a similar assignment in their classrooms should consider the following recommendations:

- Include clear documentation about the responsibilities associated with each group member’s role (e.g., host, scholar, information professional, etc.).
- Consider eliminating the producer role, to encourage everyone to work together to manage the project.
- Support project management with collaboration and file-sharing software (e.g. Google Docs, Dropbox). This is especially important for students who commute to campus.
- Direct students to on- and off-campus recording resources (e.g., university and public libraries). One student suggested “including a listing of ‘X, Y, and Z spaces [that] contain the necessary recording equipment and may be booked’ in the assignment outline.”
- Another student emphasized the importance of timing rehearsed talks “before you actually record the final [episode].”
- Encourage students to read from an outline as opposed to an entirely scripted episode, as it results in a more natural-sounding conversation.
- Connect playlist listenings to weekly lecture topics. One student recommended that these direct connections could be made through “a short group discussion at the beginning of class on how we thought that week’s episodes connected to the themes of the course.”
- Educators may also consider facilitating a transcription exercise or workshop, as one student suggested, to provide “an opportunity for students interested in methods to assist those with hearing challenges.”
While this course was not delivered online, the *In Our Time* LIS playlist and assignment have potential for online learning. To support group collaboration, online courses could design the assignment with smaller groups and use existing course portals and other software to support remote collaboration.

**Conclusion**

By reviewing cases of applying multimedia resources in master’s and doctoral courses, this article is intended to help readers diversify pedagogical strategies. We recognize that the choices educators make about how they teach classes have significant effects on students’ learning experiences. In addition to sharing ideas about incorporating multimedia into instructional design to supplement assigned readings from scholarly LIS literature, this paper works toward finding tools and techniques that facilitate public awareness about librarianship and information science, as interest in careers in information professions increases and universities launch new undergraduate degree programs (e.g., the University of Michigan’s Bachelor of Science in Information). Posting video-recorded lectures and student-produced podcast episodes on publicly accessible platforms are two of the ways in which people outside the classroom may encounter and learn about the history of our field and the contemporary issues facing information professionals. Additionally, by including multimedia resources into course designs, educators may help to empower students to actively and creatively apply what they learn in class to historical events, biographies, and social movements, and to develop technical skills that will benefit their professional development. Finally, these approaches parallel the new popularity of amateur science as a hobby and seeking and sharing knowledge online, away from the traditional classroom (Falk & Dierking, 2010).

Ongoing discussions of the use of multimedia resources in LIS curriculum design will benefit from future research. The cases presented here are not part of fully online course models (e.g., MOOCs) but are reviewed as ways to enhance in-class learning. Further research may follow Saunders and Hutt’s (2015, p. 1247) recommendations to pay “closer attention to the pedagogy and purpose of the rich-media materials within the overall course design,” consider how “interactive online resources (discussion boards and other feedback mechanisms) might enhance learning,” and test “how student-generated rich-media content could be incorporated within the course unit.” While this article has described multimedia resources that were used to enhance classroom-based learning, these kinds of resources may also be included in online course designs. Future research by educators and practitioners is needed to investigate considerations about digital preservation (i.e., the durability of multimedia resources and outputs created as part of assignments) and the impact of recording lectures on accessibility and student learning/performance.
Elysia Guzik completed her PhD and Master of Information Studies at the University of Toronto. She has published on autoethnography, information sharing as embodied practice, mindfulness meditation in the classroom, and Muslim veiling in Quebec, Canada. She is currently a research associate at Brock University, where she conducts interviews and qualitative analysis for assistant professor Karen Louise Smith’s Mozilla Research Grant–supported privacy add-ons project.

Brian Griffin is a PhD candidate in the Faculty of Information at the University of Toronto. He is studying how people use various kinds of information in physical activities, particularly music practice and performance. His current research focuses on the information activities of amateur and student musicians.

Jenna Hartel is an associate professor at the Faculty of Information, University of Toronto, and the creator of the iSquare Research Program, an arts-informed, visual study of information. As an interdisciplinary social scientist, she conducts research in three related areas: information phenomena in serious leisure, ethnography and visual methods, and the history and theory of information studies.

Notes
1. At the time of writing, the University of Toronto does not have an institutional mandate to supplement or replace textbooks with open educational resources (OER). Some professors choose to make selected materials, such as syllabi, publicly available online through their own websites.

2. Podcasts are defined as “digital media files distributed through the Internet and downloaded through syndication for playback on a computer or MP3 player” (O’Bannon et al., 2011, p. 1885).

3. In their respective capacities as course instructor and teaching assistant, Professor Hartel and Elysia Guzik obtained students’ consent to include their survey responses in presentations and publications related to pedagogy. Out of 99 students, they received 34 survey responses.

References
BBC Radio 4. (n.d.). In Our Time archive. Retrieved from https://www.bbc.co.uk/programmes/articles/2Dw1c7rxs6DmyK0pMRwpMq1/archive


Appendix A: In Our Time Assignment Description (including LIS Playlist)

**Overview**

This assignment provides a complementary perspective on the issues raised in *INF1300: Foundations of Library and Information Science* (LIS). It leverages the medium of broadcast and specifically the BBC Radio 4 history of ideas program, *In Our Time (“IOT”)*. Over the course of the semester, you will listen to a selection of *IOT* episodes that address key issues, people, and events associated with LIS. Further, working together in small groups, you...
will mimic the *IOT* format and style to produce and record an original 10-minute mini-episode on a relevant foundational (to LIS) topic of your choice. The mini-episodes will be played and celebrated during the last session of the semester, contribute to the final grade, and be mounted online for all to enjoy.

**Background on In Our Time (from Wikipedia)**

*IOT* is a live radio discussion series exploring the history of ideas. British broadcaster and parliamentarian Melvyn Bragg (shown at right) created the program in October 1998 and serves as its host. The series is very popular and attracts a weekly audience in the UK exceeding two million listeners. Each program entails a 42-minute discussion of a specific historical, philosophical, religious, cultural or scientific topic among Bragg and three world-class academics. Episodes are structured as follows: a short opening statement by Bragg; introduction of the scholars; Q & A discussion period; and then a closing summation by Bragg or one of the guests. There are more than 700 episodes to date and the entire corpus is available for streaming or download at the *In Our Time* Archive.

**Professor Hartel’s perspective on In Our Time**

I discovered *IOT* a year ago when Googling to learn more about the anthropologist Claude Levi-Strauss, and the episode on Levi-Strauss initiated my fascination with the series. I loved Bragg’s relentless and astute questioning and the thoughtful interplay that ensued between the scholars. The theorist Howard D. White asserts that librarians tend to have “scrapbook minds” and are attracted to a wide range of topics. For me, the dazzling array of subjects in the *IOT* corpus hits that sweet spot. I began listening to one episode per day, with the intent to hear them all. Soon I realized that many episodes addressed central topics and themes in LIS and decided to coordinate a collection that could be used by our students.

Be mindful that the objective of listening to *IOT* is not to memorize facts (e.g. When was the information technology pioneer Ada Lovelace born? How was the French encyclopaedia, the *Encyclopédie*, organized?)—though it is a great resource for factoids and party banter. Rather, the point is to realize broad parallels and other relations between the topics and LIS today. For example, the *IOT* episode on *The Druids* profiles a highly educated class of experts in ancient Celtic society and reveals their authority over religious and legal affairs. It is an opportunity to reflect: How is authority established in society today and what can be gleaned from this bygone example? Or, the episode on *The Great Exhibition of 1851* revisits a landmark effort to disseminate technical knowledge across an increasingly industrialized and globalized society. Here one
can realize that concepts such as information access and the digital divide are not unique to our Information Age, and that the Great Exhibition set up a model that museums and libraries still follow in their exhibition practices nowadays. As you listen through the semester, do your best to forge linkages between each IOT episode and issues in our current Information Age.

Putting the excellent content aside, there are additional reasons to study and appreciate IOT. Firstly, IOT aims to bring the general public into the “ivory tower” of academe, thereby upholding the egalitarian spirit and core value of librarianship of equal access to information. Secondly, the short opening statement by Bragg is an intriguing genre in its own right. In less than a minute it captures the imagination by juxtaposing vivid anecdotes with pithy questions; it is a great recipe to learn when one must quickly garner the interest of any audience. Thirdly, Bragg’s interrogation throughout the Q & A period is masterful; he applies chronological, comparative, and narrative rhetorical strategies, among others, that could be put to good use in your own work. Finally, the guest scholars are accomplished debaters. Take note that a diplomatic manner, accurate details, proper citing, and a knack for succinct storytelling are essential ingredients when making an expert point or counterpoint.

The playlist
One semester is not enough time to listen to all 700+ episodes of IOT; nor are all topics highly relevant to the LIS domain. Therefore, a playlist of the worthiest episodes has been created, using the INF1300 course syllabus and the Encyclopedia of Library and Information Sciences, 3rd edition as screening mechanisms. It is important to note that the Playlist does not replicate the content of this course; it is not an online alternative. Rather, it complements the issues raised in class and across the syllabus by providing a broader, longer, sometimes soaring back story.

Practically speaking, the Playlist contains a selection of hyperlinked IOT episodes in a thematic listening sequence that is synchronized with the INF1300 syllabus week-by-week. The Playlist also contains a contextual statement by Professor Hartel that should be read in advance of listening. Prior to class each week you are to listen to three episodes from the Playlist; in most cases two episodes are required and a third can be “your choice.” Altogether, you will listen for 2.5 hours of IOT per week. Ideally the episodes will be given your undivided attention, but they can also be enjoyed while you are commuting, exercising, or eating/drinking. As motivation to stay current with the Playlist, two unannounced “Ticket Out the Door” (TOtD) assignments will occur during class (the questions target the required episodes only)—see the INF1300 syllabus for details on the TOtD assignments.
<table>
<thead>
<tr>
<th>Session</th>
<th>Theme</th>
<th>Required episodes</th>
<th>Your choice</th>
<th>Contextual statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>INTRODUCTION TO LIS</td>
<td>The Library of Alexandria, Memory and Culture, Artificial Intelligence</td>
<td>Visit the <em>In Our Time</em> Archive and peruse the collection. Come to class prepared to share the title of an episode that captured your imagination.</td>
<td>The academic discipline of LIS and the related profession of librarianship maintain the external memory of humankind through libraries and technology. This week’s episodes will put you in the mood for LIS!</td>
</tr>
<tr>
<td>2</td>
<td>READING &amp; WRITING</td>
<td>The Alphabet, The History of Reading</td>
<td>17th Century Print Culture, The Lyrical Ballad, Rhetoric, Caxton and the Printing Press</td>
<td>Reading and writing are central practices in the production of external memory, or culture. This week’s episodes provide a history of each.</td>
</tr>
<tr>
<td>3</td>
<td>METATHEORIES (“...ISMS”)</td>
<td>Relativism, Empiricism, Humanism</td>
<td>Pragmatism, Cynicism, Existentialism, Bohemianism, Anarchism, Epicureanism, Materialism, Nihilism, Scepticism</td>
<td>LIS is not a theoretically neutral enterprise. This week’s episodes are an opportunity to engage major paradigms and theories and reflect on their contemporary impacts and manifestations.</td>
</tr>
<tr>
<td>4</td>
<td>EXPERTISE AND COGNITIVE AUTHORITY</td>
<td>The Abbasid Caliphs, Samuel Johnson</td>
<td>The Royal Society, The Jesuits, The Druids, Sturm Und Drang, The Lunar Society</td>
<td>LIS contributes to expertise in society by endorsing scholars, authors, and librarians—among other favoured authorities. At the same time, LIS champions individual learning. This week’s episodes reflect on all kinds of expertise and the social systems that enable them.</td>
</tr>
<tr>
<td>5</td>
<td>ORGANIZING SYSTEMS</td>
<td>The Encyclopédie, The Natural Order, The Fibonacci Sequence</td>
<td>The Calendar, The Measurement of Time, Chemical Elements, The Four Humours, Euclid’s Elements</td>
<td>LIS and the information professions are tasked with organizing knowledge through bibliographic control, classification, cataloguing, and metadata. This week’s episodes display historical efforts to organize knowledge.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Session</th>
<th>Theme</th>
<th>Required episodes</th>
<th>Your choice</th>
<th>Contextual statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>INFORMATION TECHNOLOGY</td>
<td>Ada Lovelace The History of Optics</td>
<td>Information Technology, The Invention of Radio, The Invention of Photography, Thomas Edison, Cryptography, The Needham Question</td>
<td>Technology is central to LIS. This week’s episodes celebrate earlier forms of technology and technological pioneers.</td>
</tr>
<tr>
<td>7</td>
<td>THE MIND</td>
<td>The Brain: A History Imagination and Consciousness</td>
<td>Language and the Mind, Memory, Originality, Intelligence, Perception and the Senses, Neuroscience</td>
<td>The human experience of information is called <em>information behaviour</em> and it always involves the mind. This week's episodes explore the workings of cognition.</td>
</tr>
<tr>
<td>8</td>
<td>SCIENCE &amp; ART</td>
<td>The Scientific Method The Artist</td>
<td>Science in the 20th Century, The Scientist in History, Women and Enlightenment Science, Michael Faraday, Charles Darwin, Robert Boyle, The Curies, Relativity</td>
<td>LIS and academic librarianship help to construct and maintain the disciplines. Each academic discipline (and sub-discipline) has distinct means of generating knowledge. This week's episodes are an opportunity to compare the nature of knowledge in science and the arts.</td>
</tr>
<tr>
<td>9</td>
<td>SOCIAL EPistemology</td>
<td>The Medieval University The Great Exhibition of 1851</td>
<td>Education, The Renaissance, The British Enlightenment, The Industrial Revolution, The Translation Movement, The Carolingian Renaissance, Progress</td>
<td>A big idea in LIS is “social epistemology,” which refers to the way information flows through society. This week's episodes are historical examples of large-scale information flows.</td>
</tr>
</tbody>
</table>

(Continued)
### The playlist

<table>
<thead>
<tr>
<th>Session</th>
<th>Theme</th>
<th>Required episodes</th>
<th>Your choice</th>
<th>Contextual statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>GREAT TEXTS IN CONTEXT</td>
<td>The Domesday Book, Anatomy of Melancholy</td>
<td>Strabo’s <em>Geographica</em>, The <em>Kama Sutra</em>, James Joyce’s <em>Ulysses</em>, Weber’s <em>The Protestant Ethic</em>, <em>Don Quixote</em>, The Lindesfarne Gospels, Pliny’s <em>Natural History</em>, The Works of William Shakespeare, <em>Uncle Tom’s Cabin</em>, <em>The Talmud</em>, <em>The Upanishads</em></td>
<td>Books have tremendous impact on society. Indeed, libraries came into being to make recorded information available to people via books (and their earlier counterparts). This week’s episodes celebrate the power of books.</td>
</tr>
<tr>
<td>11</td>
<td>MODERNITY</td>
<td>The Industrial Revolution, The Frankfurt School</td>
<td>Consequences of the Industrial Revolution, <em>The Wasteland</em> and Literary Modernity, The City in the 20th Century, Multiculturalism, Complexity; Truth, Lies and Fiction</td>
<td>The Foundations course, <em>IOT</em>, and this Playlist have a strong historical spirit and orientation. This week’s episodes present movements and ideas that stand markedly in contrast with the past. Consider: How is the library adapting to modernity?</td>
</tr>
<tr>
<td>12</td>
<td>YOUR TURN!</td>
<td>Your mini-episodes produced will be played in class.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For our purposes, there are problems with *IOT* and hence the Playlist: 1.) The content is not framed from the perspective of LIS; 2.) There are no unifying themes that link episodes together; 3.) There are significant gaps in coverage when held up against the ideal of a complete statement on the foundations of LIS; and 4.) The program features the perspective of Great Britain. The shortcomings create corresponding growth opportunities for you to independently and creatively frame and unify the material while listening and to fill in the gaps when producing a mini-episode.

**The mini-episode**

Groups of six will work together to create a 10-minute mini-episode on a foundational topic of LIS in the style and format of *IOT*. The project is an opportunity to analyze a singular multimedia genre; master its associated technology; gain expertise on a foundational topic of LIS; and practice
collaboration among peers. The Teaching Assistant will manage the assignment and provide assistance; she can be contacted by email or visited during her weekly office hours.

Groups
Groups will be convened at Session 7 and class time will be provided at key junctures to work together. Additional group meetings and independent work will be necessary outside of class. To facilitate effective collaboration, each group member will commit to one of the roles described in the table below.

<table>
<thead>
<tr>
<th>Role</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Producer</td>
<td>Takes the lead in project coordination. Establishes and maintains team vision, timeline, communication, problem-solving, and documentation.</td>
</tr>
<tr>
<td>Host</td>
<td>Plays the role of Melvin Bragg during the mini-episode. Designs questions, masters the material provided by the scholars, and keeps the conversation going while on the air.</td>
</tr>
<tr>
<td>World-class scholar #1</td>
<td>An authority on one aspect of the topic and communicates expertise during the broadcast. Provides notes to the host and develops answers to his/her questions in advance of the broadcast. May or may not be based on a real person.</td>
</tr>
<tr>
<td>World-class scholar #2</td>
<td>An authority on one aspect of the topic and communicates expertise during the broadcast. Provides notes to the host and develops answers to his/her questions in advance of the broadcast. May or may not be based on a real person.</td>
</tr>
<tr>
<td>World-class (information) professional</td>
<td>An authority on one aspect of the topic (from a professional perspective) and communicates expertise during the broadcast. Provides notes to the host and develops answers to his/her questions in advance of the broadcast. May or may not be based on a real person.</td>
</tr>
<tr>
<td>Technical manager</td>
<td>Masters and oversees the technical process and infrastructure. Produces final audio product for replay at the final class and submission to the dedicated project website.</td>
</tr>
</tbody>
</table>

Topics
Topics for the mini-episode are to be drawn from the Table of Contents of the Encyclopedia of Library and Information Sciences, 3rd edition (ELIS). Any ELIS chapter (or section therein) may be a topic. Examples of promising topics are: Archival Science, Informatics, Indigenous Librarianship, Genre Theory and Research, Information, Knowledge, Information Overload, Citation Analysis, Ethical Issues in Information Systems, and Museum as Place. The ELIS article can be used as a starting point but additional research will be required to develop content. Another option for a topic is to focus on an LIS luminary, such as Melvil Dewey, S. R.
Ranganathan, Jesse Shera, Suzanne Briet, Eugene Garfield, or Marcia Bates. All topics are to be approved by the Teaching Assistant at Session 8.

**Schedule of in-class workshops**
Across the second half of the semester, time will be available during class for groups to work on their mini-episode:

- **Session 7**—*IOT* Project Workshop 1 (assignment launch, group formation, topic brainstorming)
- **Session 8**—*IOT* Project Workshop 2 (technology primer, topic selected and sent to TA)
- **Session 9**—*IOT* Project Workshop 3 (group work time)

**Timing, style, and spoofing**
Your mini-episode should be 10-minutes in length, which is much shorter than the 42 minutes of a complete *IOT* episode. Therefore, your mini-episode can be designed as the first part of an imagined longer broadcast—a teaser of sorts. Be certain to model as many stylistic and structural features of your mini-episode on the precedent that exists in *IOT*. You may wish to imitate Bragg’s manner of asking questions and directing speakers to comment. (Bragg’s persistence to reach clarity on a confusing matter or accelerate/decelerate the pacing is especially recognizable.) You may judiciously enact a spoof of Bragg and/or *IOT*, but the assignment is, at heart, to be taken seriously and must contain excellent content on your topic as well as high production value.

**Audio-recording technology**
Technological specifications concerning the software, equipment, and file formats to use for the project will be announced in class during the *IOT* Project Workshop 2; a brief primer on these tools will also be provided. You may wish to Google “audio drama production” to access blogs and podcasts that contain technical tips on this project.

**Evaluation criteria for the IOT mini-episode**
As mentioned earlier, the listening portion of this assignment will be captured in two unannounced, pass/fail, “Ticket Out the Door” assignments that target the required episodes only. The mini-episode will be played during Session 12 and evaluated by the Professor and TA based upon:

- Quality of the content
- Quality of the audio production
- Resemblance to *IOT*
- An engaging in class presentation (see below).

**Mini-episode submission, presentation, and public access**
A file of your episode must be emailed to the TA by [due date]. The email must also contain the title of your mini-episode and full names of group members and their roles. During the last class, your team will present its mini-episode. At that time, your team is to: come to the front of the room,
introduce yourselves and state your roles; state your topic and why you chose it; and share one or two anecdotes of interest about the project. Soon thereafter, the mini-episodes will be mounted on a website for all to enjoy.

Appendix B: In Our Time assignment technical appendix

Download Audacity at: http://www.audacityteam.org/

In addition to the software itself, make sure you download the LAME library MP3 encoder, which allows Audacity to export your audio as MP3 files.

Details for Mac: http://manual.audacityteam.org/man/faq_installation_and_plug_ins.html#maclame

Details for Windows: http://manual.audacityteam.org/man/faq_installation_and_plug_ins.html#lame

Remember to regularly back up your files. Helpful tips here: http://manual.audacityteam.org/man/faq_opening_and_saving_files.html#backup

Save both the individual.aup file (to be exported as .mp3) and the project folders the software generates from your recording.

Built-in microphones help to prevent importing issues.

Leave yourself enough time to upload your MP3 to the university library’s archival storage and streaming platform as it can take up to 24 hours to process the file. Once you receive the email notifying you that the file has been processed, update the title of the audio file (with your topic, group number, section, and course code) and the description if you wish to add further details. Set access restrictions. Select Media Download Link. Then, send the course instructor/TA an email with that link.

Keep at least one copy of the MP3 on a USB key; bring this USB to class presentations in Week 12.

Episodes must run at least 9 minutes, and no longer than 12 minutes.

Thank you to INF1300 Foundations of Library and Information Science Fall 2016 alumnus, Martin Chandler, from the Faculty of Information at the University of Toronto for the following technical guidelines on using Audacity for recording your mini-episode:

Soundscape/acoustics
Your microphone will reflect the sounds around you. Try to find somewhere reasonably quiet. Pay attention to the latent sounds of the room, too: Any fans running? Odd sounds you hear? What’s the soundscape?

Microphone
Your computer’s built-in mics are fine, but the better the mic, the better the sound. The library has one to use—just make sure you return it, rather than keep it out for the 2 days, so that the other groups can use it, too! There’s a dropdown menu to choose which microphone you’re using. (If you don’t see the new mic in the dropdown menu, you may need to close Audacity, and reopen it.)
Basic functions
Record, stop, pause, play. Record records. Pause will pause the recording (or playback), and allow you to continue from that point. Stop ceases the recording, so if you click “record” again, it will start a new track. Play lets you listen back to what you have recorded.

Recording
Avoid peaks! You can adjust how much the microphone picks up with the slider on the right (it has a picture of a microphone next to it).

You can use your cursor to decide where a new track will start recording (the first one will start at 0'00", of course, but once you have one track, you can then click somewhere in that track and you’ll see a black line. If you then press record, it will start a new track from the point at which you set the cursor).

Files
When you save a file, it will save as [Filename].aup. You will also see a folder named [Filename]_data. Keep these items in the same place, as the .aup will get its data from the folder. Do NOT put [Filename].aup inside [Filename]_data. However, you may put these two things into another folder to move around; just keep them together, in the same folder, as two distinct entities, so your .aup file knows where to find the data.

Work with the .aup file until you think it’s ready to listen to. When you export to .mp3, it will merge all tracks into one.

Export
When you’re all done, go to File > Export, and you can export it to an mp3 (provided you’ve set things up for that).

New track
If you press the stop button. Pause won’t do that. It’s your choice, just make sure you mute the previous track when you start a new one.

Name tracks
(“Take 1,” “Take 2,” etc.; or “Intro,” “Scholar 1,” “Scholar 2,” etc.)

To do this, click on “Audio track” on the left side of the track (above the mute button). It’s a good way to keep everything organized.

Combine tracks
The best way is through highlighting what you want to combine, then copy and paste. You can control exactly where it gets pasted with more ease.

Copy and paste
For repeating sound (like making a constant drone)—it can make funny hiccups. There are ways to reduce that, but it’s imperfect. Best not to use when possible.

Removing unwanted noise
Highlight a quiet point that has the sound you want to remove—the more you can choose, the better, but it will work with only a second or two. Under “effect,” click on “Noise Reduction,” then press the button “Get Noise Profile.” Now highlight the whole track, and go to Effect > Noise Reduction again. Then click “Okay.” It will reduce the overall sound a bit—you’ll likely see the whole blue spikey thing get a bit smaller. However, the noise that was bothering you will be reduced (you can’t get rid of it entirely). You can boost the rest of the sound, but the noise that was bothering you, while reduced, will get louder with the rest of the sound. It’s kind of a balancing act between the two.

**Boosting (or reducing) overall sound**
Highlight what you want, and under “Effect,” choose “Amplify.” You can use the slider, or just the numbers. I generally keep it a few dBs lower than suggested, as Audacity will try to take you right to the limit. Just because you have the space to do so, doesn’t mean you should, so whatever it suggests, I’ll generally knock back by 1–4 dB. It won’t let you peak, so it will take the loudest section, boost it to the limit, and boost everything by that amount.

You can also put a negative number in, to make everything quieter.

**Add silence**
You’ll want about 1–2 seconds of silence at the start of your recording. You can add silence to any point after you’ve recorded your track. Click where you want the silence, then under “Generate,” choose “Silence” and adjust how long you want the silence to be.

**Import music file**
You can drag and drop. If that doesn’t work, you can also go to File > Import, choose the file, and it will be imported, usually as a stereo track.

**Fade in and fade out**
Highlight how long you want the fade in/fade out to last, then go to “Effect,” and choose either fade in or fade out. Audacity will do the rest for you!

**Zoom in and zoom out**
See the specific section you’re working on more closely.

**Speed**
THIS IS DANGEROUS. But if you find you’re at 11 minutes and 20 seconds, and you need to knock off those extra 20 seconds, you can play with the speed. Go to Effect > Change Speed. BE CAUTIOUS, DO SMALL CHANGES. Anything larger than 10 percent, and it will be noticeable—you’ll start to sound like The Chipmunks. Small changes, and only enough to get done what you need.

Always listen to everything that you do a few times. Make sure it sounds good. Then export, and keep the original Audacity file, too.
Unneeded, but interesting to play with:

Click track
If you decide to make some music with Audacity later, it’s quite useful for a steady beat. You’ll find it under Generate > Click Track

Pitch changing
If you have some spare time and feel like having fun, you can create modern music by auto-tuning everything! Under Effect > Change Pitch. Best if know your pitches, and the corresponding hZ (you can look up tables for standard pitches online—most North American music is based around A440).

Sound quality
When recording, do a sound check first! Click the record button, and say a few words. You should see a waveform on the track being recorded (i.e. blue spikes). In the top right, as the speaker is speaking, you’ll see the microphone monitor bouncing around—in the video we watched in class, the person said that “red = bad.” That’s true. If your sound pushes right to the edge of the microphone input monitor, you’ll have a peak in the sound. When you try to listen back to it, the audio at that point will have a crackling, distorted sound to it. There’s no way to fix that other than re-recording that section. You can adjust how much the microphone picks up, using the slider for the microphone (under the pause-play-stop buttons on the top left corner).

Mute previous tracks
When recording new takes, mute previous tracks using the mute button on the far left.